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Introduction

This manual gives instructions on how to set up and use your Nanosurf
easyScan E-STM system. The aim is to help people who don’t have a good
knowledge of physics to get pictures of atomic resolution easily. This intro-
duction chapter gives some general information on the scanning tunneling
microscopy technique, and its implementation in the easyScan STM. The
next chapter, (Un)packing and Installation, should be read when installing
your easyScan system. The chapters Preparing for Measurement and First
Measurements should be read by all users, as they contain useful instructions
for your everyday measurements. The other chapters give more informa-
tion for advanced users. Those who need a more detailed description of the
functions of the easyScan software should refer to the Software Reference
manual.

What is STM?
Microscopy is one of the most exciting scientific techniques. The insight
into small dimensions has led to a new understanding of the structure of
materials and forms of life.

With the help of the scanning tunneling microscope (STM) it is possible to
look into the fascinating world of the atoms. This completely new micros-
copy technique works without focusing elements and features atomic reso-
lution (laterally and vertically).

The Scanning Tunneling Microscope was developed by Gerd Binnig and
Heinrich Rohrer in the early 80’s at the IBM research laboratory in
Rüschlikon, Switzerland. For this revolutionary innovation Binnig and
Rohrer were awarded the Nobel prize in Physics in 1986.

In the STM, a small sharp conducting tip is scanned across the sample’s
surface, so close that the so-called ‘tunneling current’ can flow. With the
help of that current the tip-surface distance can be controlled very precisely.
Therefore an enormous resolution is achieved so that the atomic arrange-
ment of metallic surfaces can be ‘probed’.

INTRODUCTION WHAT IS STM?
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To be able to get such excellent pictures of atomic resolution is almost in-
credible, considering that the size of the atom in relation to the tip, is that of
a golf ball to a mountain!

Scanning with the E-STM
In the E-STM, two tiny springs clamp a platinum-iridium tip onto a plat-
form which can be moved in three dimensions using piezo-crystal transla-
tors that are driven with sub-nanometer precision.

INTRODUCTIONSCANNING WITH THE E-STM
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The sample to be examined approaches the tip within a distance of 1 nano-
meter (1nm= 1 / 1 000 000 000 m). Classical physics would prohibit the
appearance of electrons in the small gap between a tip and a sample, but if
a sharp tip and a conducting surface are put under a low voltage (U~0.1V)
a very small tunneling current (I~1nA) may nevertheless flow between tip
and sample. This tunneling current is due to a quantum physics effect.

The strength of the tunneling current depends exponentially on the dis-
tance between the tip and the sample (usually referred to as z-distance).
This extreme dependence on the z-distance makes it possible to  measure
the tip-sample movement very precisely. One of the three piezo crystals, the
z-piezo, can now be used in a feedback loop that keeps the tunneling cur-
rent constant by appropriately changing the z-distance.

To obtain an image of the sample, the tip is scanned using the x- and y-
piezo crystals. The feedback loop will now let the tip follow the structure of
the sample's surface. A height image can now be made by recording the
position of the z-feedback loop as a function of the x-y piezo position. This
‘landscape’ (or topography) of the atomic surface is then drawn on the com-
puter screen line by line.

x

z

I = const.

The feedback loop maintains a constant tunneling current between the tip and the sample
during motion in the x-direction by changing the z-direction (viewed from top)

INTRODUCTION SCANNING WITH THE E-STM
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Scan-images of graphite as views from the ‘side’ and the ‘top’

The sample can also be scanned in a second mode:  When the feedback
loop is slowed down very much (P-Gain=0, I-Gain=2), the tip scans at a
fixed distance from the sample (constant height mode). This time the vari-
ations in the tunneling current are measured and drawn line by line on the
computer screen. However, this mode only works when the sample is atomi-
cally flat, because the tip would otherwise ‘crash’ in to the sample

What is so special about the Nanosurf easyScan E-STM?

The E-STM was designed to allow people without training as a physicist to
do experiments in the world of atoms. Its design is compact, simple and
comfortable to operate. With the E-STM, it is possible to do any STM
experiment which can be carried out in air. The special sample approach
system allows simple handling of samples and tips, whilst at the same time
providing maximum stability of the tip-sample distance. All functions can
be carried out using a computer and the E-Line software.

INTRODUCTIONSCANNING WITH THE E-STM
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(Un)packing and Installation

This chapter describes the installation of the Nanosurf easyScan E-STM.

Important!

To enable measurements of atomic resolution to be made the following
precautions must be taken to keep equipment dust and grease free:

• Never touch either the wire for tips (figure components, 8 e), the sample (8
g) nor the open part of the STM scan head (2) with your fingers.

• Only touch the sample holder (8 f) at the black plastic end.

Unpacking the instrument
Before unpacking the instrument suitcase, check for the following items:

Documents and
 software(9)

1

2
3

54 8

6
7

c d

b
f
g

e

a

Components: The easyScan DFM system

(UN)PACKING AND INSTALLATION UNPACKING THE INSTRUMENT
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1 - easyScan E-SPM electronics

2 - STM scan head

3 - Power supply LPS-1

4 - RS232 cable between computer and control electronics

5 - Mains cable

6 - Vibration isolation platform

7 - Magnifying cover with 10x magnifier

8 - Tool set, containing a: wire cutter b: half-round pliers, c: pointed tweez-
ers, d: rounded tweezers, e: 30 cm Pt/Ir 0.25mm wire for tips, f: sample
holder, g: sample set: HOPG (graphite), gold thin film, three empty
sample supports

9 - easyScan E-Line CD, containing the easyScan E-Line software

- this manual

- software reference manual

- a test sheet and a sheet with the calibration information.

- a Case for storing and transporting the instrument

Additionally, the following material is needed that is not included with the
contents of delivery:

• A computer that meets the requirements described in the section Software
Installation.

• Solvent to clean the tools (e.g. ethanol, acetone)

Hardware Installation

Important!

- Please check that the mains voltage corresponds to that of the power sup-
ply (3).

- Make sure that your mains connection is protected against excess voltage.

(UN)PACKING AND INSTALLATIONHARDWARE INSTALLATION
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Choose a steady table where you can work undisturbed. To ensure the fault-
less operation of the STM it has to be kept away from vibrations, heat
emission and air current.

- Put the STM scan head (2) onto the vibration isolation platform (6). Fix
the scan head cable under the strain relief clip.

- Connect the STM scan head to the easyScan E-SPM electronics (1).

- Make sure your computer is turned off. Then connect the control elec-
tronics to a free serial port (or RS232, or COM Port) on your computer
with the RS232 cable (4). If you are using the ‘USB adapter for easyScan
electronics’, DO NOT connect it now.

- Connect the power supply (3) to the E-SPM electronics, and plug in the
mains cable (5).

- Finally turn on the power supply.

Now the E-SPM electronics and the microscope are connected, and the
LED on the E-SPM electronics flashes.

(UN)PACKING AND INSTALLATION HARDWARE INSTALLATION
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Software installation

System requirements
The System requirements for the easyScan E-Line software are:

• PC with a Pentium 133 MHz processor or higher

• a free COM-Port or USB port.*

• Windows 95 or higher

• 8 MB RAM or more (16 MB recommended)

• graphics adapter with 800 x 600 resolution and 16-bit colours (‘high
color’) or better (resolution of 1024 x 768 recommended)

* The Nanosurf ‘USB Adapter for easyScan’ option must be acquired to
use the USB port.

Installation Procedure

- Turn on your computer and start Windows.

Do not run any other program while installing the scan software.

- If you are using the USB Adapter for easyScan, install it first according to
the instructions included with the adapter.

- Insert (the backup copy of ) your E-Line CD.

Windows NT/2000/XP

- Make sure you have administrator privileges before installing the soft-
ware.

All operating systems

- Start the ‘setup.exe’ program on the CD.

The following screen will now appear:

(UN)PACKING AND INSTALLATIONSOFTWARE INSTALLATION
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- Select the button ‘Install’, to install the data acquisition program ‘easy-
Scan’ on your computer.

Setup will ask for the directory in which the program files are to be copied:

- Put them in the proposed directory, unless the ‘Program Files’ directory
has a different name in your language of the Windows operating system.

Afterwards setup will ask for the start menu entry or program group in
which ‘easyScan’ is to be placed:

(UN)PACKING AND INSTALLATION SOFTWARE INSTALLATION
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- Accept the proposed name by clicking ‘OK’ or type another name.

The installation setup will now ask for the ’COM-Port’:

- Select the serial port to which you have connected the E-SPM electronics
(See section hardware installation, figure components, 1)

The setup program will start copying files onto your hard-disk.

After successful installation you will get this confirmation:

Important!

The E-Line software CD delivered with the instrument contains calibra-
tion information specific to your instrument, therefore you should there-
fore always keep (a backup copy of ) the CD delivered with the instrument.

(UN)PACKING AND INSTALLATIONSOFTWARE INSTALLATION
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Simulated microscope
You can start the easyScan software without having the microscope con-
nected to your computer. We recommend using this simulation to explore
the easyScan-system (measurements and software) ‘off-line’.

When the simulate microscope mode is started, the following dialog box
appears:

By clicking ‘Start Simulation’ a simulation of the microscope is started.
This imitates most of the functions of the real microscope. The sample is
replaced by a mathematical description of a surface. You can now follow the
instructions in the chapter First measurements.

- To explore the system in the ‘Simulate Microscope’ mode with the micro-
scope connected, activate it in the menu ‘Options’.

(UN)PACKING AND INSTALLATION SOFTWARE INSTALLATION
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Preparing for Measurement

Preparing and installing the STM tip
The STM tip is prepared and installed by you. This is the most difficult
part of your preparations. It usually needs patience and some practise to get
the first good tip. Only an accurately cut tip enables optimal measurements.
Therefore, cutting and installing should be carried out with great care.

- First ensure that the cutting part of the wire cutters (figure components, 8
a), the half-round pliers (8 b) and the pointed tweezers (8 c) have been
cleaned with ethanol. Touch the Pt/Ir wire (8 e) with these tools only.

- hold the end of the wire firmly with the pliers and cut a piece off approxi-
mately 5mm long.

- Still holding this piece of wire with the pliers, place the cutters at the free
end, as obliquely as possible. (See picture below)

- Close the cutters until you can feel the wire, then pull in the direction
shown below. The tip needs to be torn off rather than cleanly cut through,
in order to get the required sharp tip.

half-round 
pliers

wire cutter

pulling and cutting
direction

wire

PREPARING FOR MEASUREMENTPREPARING AND INSTALLING THE STM TIP
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Important!

• Never touch the tip end with anything!

• The golden tip holders in the open part of the scan head are very delicate
and not to be twisted or lifted too high!

- Hold the wire with the tweezers behind the freshly cut tip.

- Insert it carefully under the golden tip holder clamp in the scan head
without twisting them (see figure mounting the tip):

1. Hold the tip wire under a slight angle, and move it over the groove
against the first clamp, so that the end of the wire is under the clamp
(figure a).

2. Lower the wire so that it lifts the first clamp.

3. Push the wire in, until it touches the second clamp.

4. Lift the wire.

     

1.

2.

a)

3.

4.

6.

b)

7.

c)

5.

Mounting the tip

PREPARING FOR MEASUREMENT PREPARING AND INSTALLING THE STM TIP
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5. Push the end of the wire below the second clamp (figure b).

6. Lower the wire so that it lifts the second clamp.

7. Push the wire below the second clamp (figure c).

The freshly cut tip should be well held under the clamps and reach about 2-
3mm beyond the tip holder. The tip is now installed.

Preparing the sample
The STM can only examine electrically conductive materials. Nevertheless
the choice of material is rather small because the surface of the sample must
not oxidise, be totally clean and mirror-like to obtain useful results. Because
of this some of the samples need special preparation.

Gold thin film
Cleaning the sample is neither possible nor necessary. Never touch the sam-
ple with your fingers or put it upside down anywhere, this will only make it
unusable faster.

Graphite
The surface of the graphite sample should be cleaned every few months.
Due to the layered structure of graphite this can easily be done using a piece
of adhesive tape: (see pictures below)

      

- Put the sample on the table using the pair of tweezers.

- Stick a piece of adhesive tape gently to the graphite and then pull it off
again: The topmost layer of the sample should stick to the tape.

PREPARING FOR MEASUREMENTPREPARING THE SAMPLE
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- Remove any loose flakes with the pair of tweezers.

The graphite sample is now ready for use and may not be touched with the
fingers.

Installing the sample

Important!

Always store the sample holder in its package, in order to prevent corrosion
(see chapter Maintenance).

- Unpack the sample holder (figure components, 8 f) touching only its black
plastic handle.

- Put the prepared sample onto the magnetic end of the sample holder
using a pair of tweezers. (See below)

        

- Place the sample holder carefully in the scan head so that it doesn’t touch
the tip (see above).

- Put the sample holder down on to the guide bars first and release it gently
on to the approach motor’s support.

PREPARING FOR MEASUREMENT INSTALLING THE SAMPLE
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First Measurements

All the preparations are now done:

The STM is assembled, the software and a tip are installed and the graphite
sample is ready.

In this chapter step by step instructions are given on how to operate the
microscope and get your first pictures. More detailed explanations of the
software and the system are given in the software reference.

Important!

- Never touch the sample's surface or the tip! Good results depend strongly
on the accuracy of the preparation of the tip and the sample.

- The tip must never come in direct contact with the sample. This damages
the end of the tip, and it has to be cut again.

Starting the microscope

- Check if the power supply (figure components, 3) is connected to the AC
mains power and turn it on:

The red LED of the E-SPM electronics (1) flashes.

- Start the data acquisition easyScan E-Line software on your computer:

The main program window and a message box appear:

Now, your computer is communicating with the control electronics to ini-
tialise the system. This process is repeated every time the control electronics
is turned off and on again. When download is completed, the electronic’s
red LEDs change from flashing to constantly shining, the LED on the scan
head shines orange, and some control panels appear (see figure Main pro-
gram window). Now the system is ready to use.

FIRST MEASUREMENTSSTARTING THE MICROSCOPE
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Approaching the tip
To start measuring, the sample must be very close to the tip to enable a
tunneling current to flow. Approaching the sample without touching the
tip, is a delicate operation carried out in three steps. The LED on the scan
head tells you about the distance between the tip and the sample:

LED orange: z-piezo fully extended toward the sample: the distance
is too big, not tunneling current can be detected.

LED red: z-piezo fully retracted: The tip touched or ‘crashed into’
the sample, the tunneling current is too high.

LED green: z- piezo within the measuring range: tunneling cur-
rent should be flowing.

1. Coarse approach by hand

- Push the sample holder (figure components, 8 f) carefully to within 1mm
distance of the tip.

FIRST MEASUREMENTS APPROACHING THE TIP
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- If necessary try turning the sample holder around its axis so that the tip
points towards a mirror-like area of the sample.

- Put the magnifying cover (7) over the scan head without touching the
sample holder, place the magnifier so, that you can see the mirror image
of the tip in the sample.

The cover reduces air flow around the scan head and reduces thermal drift
in measurements at atomic scale.

2. Fine approach by piezo motor

- Open the ‘Panels’ menu in the easyScan E-Line program window.

- Select the ‘Approach Panel’.

- Watch the distance between tip and sample with help of the magnifier.
Now click  in the ‘Approach Panel’ to move the sample towards the
tip to a distance of a fraction of a millimetre.

You should only just be able to see the gap between the tip and its mirror
image the sample. The smallest visible gap depends somewhat on the obser-
vation angle of the magnifier.

FIRST MEASUREMENTSAPPROACHING THE TIP
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- Open the ‘Feedback Panel’ in the menu ‘Panels’.

- Ensure that the following parameters are set correctly:

• the ‘SetPoint’ (tunneling current) on approx. 1.00nA,

• the ‘GapVoltage’ (tip-sample-voltage) on 0.05V,

• the ‘P-Gain’ on 12 and the ‘I-Gain’ on 13 (feedback loop param-
eters).

When you have to change the instrument settings in any panel, you can use
any of the following methods to change them:

• Activate any input by clicking in it with the mouse pointer, or by select-
ing it with the Tab-key.

• The value of an activated input can be increased and decreased using the
up and down arrow keys on the keyboard. The new value is automati-
cally used after one second.

• The value of a numerical input can also be increased and decreased by
clicking the arrow buttons  with the mouse pointer. The new value is
automatically applied after one second.

• The value of an active numerical input can be entered using the key-
board. The entered value must be confirmed by pressing the ‘Enter’ or
‘Return’ key, or by clicking  with the mouse pointer.

• The selection of a drop-down menu (e.g.: ) can be changed using
the mouse. The selected value must be confirmed by pressing the ‘Enter’
or ‘Return’ key, or by clicking  with the mouse pointer.

3.Automatic approach

- Click  in the ‘Approach Panel’:

FIRST MEASUREMENTS APPROACHING THE TIP
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The sample holder is now moved towards the tip with the help of the piezo
motor, until the tunneling current entered under ‘SetPoint’ is detected. Now
the distance between sample and tip is controlled by the feedback loop. If
the approach was successful, the LED on the scan head changes from or-
ange to green and the message box ‘Approach done’ appears.

- Click the ‘OK’-button.

Now the set tunneling current is flowing between tip and sample.

When the LED changes to red instead of green, the sample has ‘crashed’
into the tip, and the tip has to be cut again. (See chapter Problems and
Solutions).

Start measurement
When the tunneling current defined by ‘SetPoint’ is flowing between tip
and sample (LED green) you can start measuring:

- Click  in the ‘Scan Panel’ to maximize the range of the scan.

- Start measuring by clicking  in the ‘Scan Panel’.

If the preparation of tip and sample, and the approach were successful,
images of the measurement will show a line in the ‘LineView’ (figure start-
ing picture, left) and a plane in the ‘TopView’. Watch the displays for a while
until the ‘TopView’-image has been drawn about three times.

A ‘nervous’ line in the ‘LineView’ indicates a bad tunneling contact (figure
starting picture, right). Usually this is caused by the tip being too blunt or
instable. This means that you should stop measuring and cut a new tip:

- Click  and follow the instructions of the chapter Problems and Solu-
tions.

FIRST MEASUREMENTSSTART MEASUREMENT
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Starting picture: left: a good LineView, right: a ‘nervous’ LineView

If the line in the ‘LineView’ is calm and reproduces consistently, you can
continue with the next section.

Adjusting the sample’s tilt coordinates
Ideally, the plane of the measurement and the sample's surface should lie in
the x-y-plane of the scanner. But mostly the sample plane is tilted with
respect to that ideal plane. In this case, the sample cross section in the x*
measurement direction, as shown in the ‘LineView’ window, has a certain
slope.

Tilt: Sample’s and measurement orientation before tilt adjustment

FIRST MEASUREMENTS ADJUSTING THE SAMPLE’S TILT COORDINATES
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This slope depends on the fast scan direction and therefore on the rotation
of the measurement, as shown in figure Tilt, position A and B. It is desirable
that the measurement plane is parallel to the sample plane, because this
makes it easier to see smaller details in the measurement, and because the z-
feedback loop can function more accurately in this case. Therefore, the sample
plane should be made parallel to the sample plane by properly setting the
values of ‘X-Slope’ and ‘Y-Slope’.

You can align the measurement plane with the sample plane using the fol-
lowing procedure:

- Alter the value of ‘X-Slope’ using the arrow buttons until the x-axis of the
scan line lies parallel to the x-axis of the sample. You can measure the
slope in the LineView using the angle tool (see Software Reference).

- Enter the value 90 in the ‘Rotation’ input to scan along the y-direction of
the scanner i.e. the sample’s tilt as shown in the schematics view B. If the
input for ‘Rotation’ is not visible, you can make it visible by clicking .

Scan panel after adjusting the slopes

FIRST MEASUREMENTSADJUSTING THE SAMPLE’S TILT COORDINATES
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- If the scan line is not horizontal, alter the value for ‘Y-slope’ until the y-
axis of the scan lies parallel to the y-axis of the sample.

- Reset the ‘Rotation’ to 0°. The ‘LineView’ shows the X-slope again.

The value of the ‘Z-Offset’ varies slightly during measurement. This is cor-
rect because the option ‘Auto. Adjust Z-Offset’ in the menu ‘Options’ should
be active.

Achieving atomic resolution
You prepared your measurement so that the scan line in the centre of the
‘LineView’ is reproducing stably. Now the scan range has to be reduced,
and the measured signals amplified in order to observe the atomic struc-
ture.

Reminder: Measurements on the nanometer scale are very sensitive. Direct
light, fast movements causing air flow and temperature variations near the
scan head can influence and disturb the measurement. It is best to let a
promising measurement run for some time to let it stabilize thermally.

The following settings apply to measurements on graphite:

1. Reduce the value of ‘Z-Range’ in ‘ScanPanel’ to 50nm in order to con-
centrate the measurement to this range.

Diminishing ‘Z-Range’ amplifies the signal in Z-direction

2. Limit the scan range:

- click the ‘TopView’-Display to make sure that it is active: its titlebar is
the same colour as the main bar.

FIRST MEASUREMENTS ACHIEVING ATOMIC RESOLUTION
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- click : The mouse pointer becomes a cross and the ‘Tool Info
Panel’ opens.

- look for a ‘flat’ region (similar grey values) in ‘TopView’ and make a
square there with the mouse pointer. The size of the square is dis-
played in the ‘Tool Info Panel’.

 

- Release the mouse button when the square’s size is about 30-50nm.

- Confirm your selection by double clicking on the display using the
left mouse button. Consequently the selection is enlarged to the whole
display size. You can abort the zoom function by clicking with the
right mouse button.

3. Atomic arrangements can normally be made out at a ‘ScanRange’ of about
4 nm and at a ‘Z-Range’ of about 1.5 nm:

- Enter these values in ‘Scan Panel’ one after the other. Play with these
values, they can be reduced even further. Between changes always al-
low the computer to scan the picture a couple of times before con-
tinuing.

- Pay attention that the height of the signal in the ‘LineView’ window
does not exceed the window height. If this happens, the z-Range is set
too small and should be increased.

Consider that one nanometer is the diameter of between four and eight
atoms.

FIRST MEASUREMENTSACHIEVING ATOMIC RESOLUTION
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4. Some parts of the scan head react to the slightest temperature changes. As
these thermal ‘movements’ influence the measurements on the nanometer
scale, the sample has to be scanned as fast as possible.

- Set the ‘Time/Line’ in the ‘ScanPanel’ to 0.06s for atomic resolution.

View Panel

- If the contrast in the ‘Top View window is too large, or too small,
open the ‘View Panel’ (see figure) and select  in the ‘Visible
Input Range’ section. You can also set the contrast manually using
‘Range’ and ‘Offset’ (See Software Reference: Section View Panel for
more information).

Good images of a successful measurement

FIRST MEASUREMENTS ACHIEVING ATOMIC RESOLUTION
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Snapshots of images
When you are satisfied with your image and would like to keep it, you can
take a snapshot and save it for later:

- During the measurement, you can select  in the ‘ScanPanel’. After
having completed the actual frame, a copy of the measured image is taken
and displayed in a separate window behind the ‘ScanPanel’.

- If you would like to take the snapshot of the view as it appears during the
measurement without waiting to finish the frame, stop the scanning us-
ing  and generate a copy of the view using .

After finishing the measurements you can store the ‘photographs’ of your
measurements in a storage medium e.g. your PC’s hard drive (see section
Finish measuring).

STM Measurement modes
The surface can be scanned in two different ways: in the  ‘Constant current’
(CC) and ‘Constant height’ (CH) mode:

In the CC-mode (default setting) the tunneling current is kept constant  by
the feedback loop and the  movements of the tip  by the z-piezo are re-
corded. This ‘height profile’ is displayed in a ‘LineView’ and the ‘topo-
graphic’ image is displayed as a grey scale coded ‘TopView’. The tunneling
current is not only dependent on the real topography but also on the local
density of the electrons. This fact has to be considered when analysing the
recorded images: the images are always  superimposed and the electronic
structure of the surface.

In CH-mode the scanning tip does not follow the samples corrugation.
This time the strength of the tunneling current is measured.  This can be
achieved by turning the feedback loop off. But then no thermal drifts in Z-
direction can be compensated for and tip crashes can not always be avoided.
This problem can be avoided by setting the feedback parameters to very low
values (1 or 2) so  that the feedback loop can follow  the slow  movements
(caused by thermal drift) of the sample. These are very small compared to
the sample’s corrugations . To measure in CH mode:

FIRST MEASUREMENTSSNAPSHOTS OF IMAGES
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- set P-Gain to 0 and I-Gain to 2 in ‘Feedback Panel’.

- apply these new values by using  .

- to visualize the current information, choose ‘Current’ as input  in the
‘View Panel’.

Notice that  ‘Z-Range’ is now called ‘InputRange’ and the corresponding
axis is labelled  ‘nA’ instead of ‘nm’.

- when displaying a ‘TopView’ image, use in ‘ViewPanel’, ‘Visible Input
Range’  in order to enhance the image’s contrast.

Judging the quality of the images
From the quality of the measured images the quality of the tip and conse-
quently that of the tunneling contact can be observed. A good tunneling
contact is necessary for high quality images of atomic resolution.

• If temperature variations are present they cause so called ‘thermal drift’.
Consequently the images are stretched. This effect can be observed when
e.g. the upward scan is very different to the downward scan showing two
differently distorted lattices.

   

Consequent upward and downward scan showing thermal drift

Thermal drift is very clearly perceptible on an atomic scale. Variations of 1/
10°C already cause variations in the length of e.g. the sample holder (steel)
of several nanometers!

To decrease thermal drift, keep the measurement running for some time to
let the system stabilize (up to about one hour).

FIRST MEASUREMENTS JUDGING THE QUALITY OF THE IMAGES



31

• If, during a good measurement the image quality diminished dramati-
cally, the tip has most probably picked up some particles or you are near
a step in the surface.

- See Problems and solutions: Image quality suddenly deteriorates’

In the following cases the tip has to be replaced i.e. cut freshly in order to
establish a stable tunneling contact and high image quality:

• If images in top view consist of only of uncorrelated lines:

• If the images are ‘smeared out’ on one border (here on the left border):

FIRST MEASUREMENTSJUDGING THE QUALITY OF THE IMAGES



32

• If each image looks different:

• If the scan lines in ‘LineView’ are unstable and the image in the ‘TopView’
is not ‘sharp’:

The graphite surface
In a good top view image of graphite you will see a pattern consisting of
white, grey and black spots. It looks like a three dimensional image of balls
lying next to each other, but be careful: these are not the single atoms!

To interpret the image correctly you must first be aware that bright spots
show high points and dark spots low ones (except in ‘LineMath’ ‘Derive’).

In the lattice model of graphite one can see that there are two different
positions of the carbon atoms in the graphite crystal lattice: One with a
neighbouring atom in the plane below (grey) and one without a neighbour
in the lattice below (white). As a consequence, the electrical conductivity of
the graphite surface varies locally slightly so that the atoms without neigh-
bours appear higher than the others.

FIRST MEASUREMENTS THE GRAPHITE SURFACE
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0.25nm
0.14nm

0.34nm

Graphite surface: left: measurement; right: lattice model

This also causes the lattice constant between the bright ‘hills’ to have the
higher than normal value of 0.25nm.

Measuring Gold
It is more difficult to obtain good images of a gold. Atomic structures are
difficult to observe because the electrons on the surface are much more
homogeneously distributed unlike graphite. But with some training the mono
atomic gold steps can be observed.

FIRST MEASUREMENTSMEASURING GOLD
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Due to the fact that the gold sample cannot be cleaned by simple means it is
possible that with time contaminants may prevent you obtaining good re-
sults.

Tip:

Before you do any experiments with the gold sample it is necessary to prac-
tise on the graphite sample. You should also test the quality of your tip
using the graphite sample.

- Proceed as you did with the graphite sample (preparation & slope com-
pensation), but there are two exceptions to note:

- select a gap voltage between 0.3-0.5V.

- increase the value of parameter ‘Time/Line’ to 0.3s in the ‘Scan Panel’.

If you do not get stably reproduced scan lines you should look for another
clean measuring spot.

- First try with  followed by . If that does not change
much retract the sample holder and rotate it a little by hand. Repeat the
approach.

- If the image reproduces stably decrease the ‘Z-Range’ to 50nm and select
a ‘ScanRange’ between 200 and 300nm.

- Now decrease the ‘Z-Range’ to 12nm or less.

Evaluate your measurements in the same way as you did with the graphite
images, zoom, measure, save etc.

FIRST MEASUREMENTS MEASURING GOLD
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Finish measuring

- To stop a measurement, click .

- By clicking , and then clicking  in ‘Approach Panel’ you
can retract the sample holder to a safe and visible distance from the tip.

- Close all panels in order to see the saved ‘snapshots’.

- Activate the ‘snapshot’ that you would like to save, by clicking onto the
image. Select the menu ‘File->Save as...’. Select the name and the folder
you would like to store the image in.

These stored images and all the corresponding data can be opened with the
easyScan E-Line software , viewed, analysed and printed any time (see also
Software Reference).

Turning off and storing the instrument

- Exit the easyScan E-Line program after having stored all desired images.
If you leave the program without saving some data the program asks if
you really do not want to save them:

If, however, you would like to save some images use . If not you can
leave the program with .

- Disconnect the power supply from the mains supply.

If you perform measurements regularly leave the instrument with the cover
over the scanner to protect it against dust.

If you do not operate the instrument for several weeks you should put it
back into the instrument suitcase:

- Remove the sample and sample holder and pack up all parts. The tip can
be left in the scanner.

FIRST MEASUREMENTSFINISH MEASURING
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- Store the sample holder in its container, and check that the silica is still
blue (see chapter maintenance)

By storing the instrument in the suitcase it is protected from dust. Simulta-
neously the rubber feet of the vibration isolation platform should be re-
lieved. The damping capability may decrease with time.

FIRST MEASUREMENTS FINISH MEASURING
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Maintenance

To ensure the fault-free operation of the microscope the following instruc-
tions for maintenance have to be followed.

Scan head
It is very important to prevent the sample holder and the open part of the
scanner from becoming dirty or damp.

• The sample holder is made of magnetic steel therefore it suffers from
corrosion in a humid environment. To reduce corrosion and increase life
expectancy, the sample holder must be stored in its container together
with the moisture absorbing silica container.

   The container is waterproof but not airtight. The silica contains a blue
indicator which turns pink when saturated. It can be regenerated by heat-
ing the silica container @ 100°C for at least two hours until it turns
completely blue again.

• If you touch the metal part of the sample holder or it does not move
freely, clean it with a soft cloth, if necessary moistened with alcohol.
During cleaning, move the cloth along the sample holder in the axial
direction, do not move it around its circumference.

MAINTENANCE
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• Clean the sample holder guide bars (see picture above), the surfaces of the
piezo motor and the tip holder with a cotton swab if necessary lightly
moistened with alcohol, ensure the tip is removed when doing this!

Scan electronics
Clean the cabinet and the controls with a soft cloth lightly moistened with
a mild detergent solution. Do not use any abrasive pad or solvent like alco-
hol or benzine.

MAINTENANCE
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Problems and Solutions

‘No connection to microscope!’

This error message appears when the scanning software is waiting for an
answer from scan electronics. This can have various reasons:

• The microscope is not connected:

- If you wish to perform a simulated measurement select .

Otherwise check the connection and select .

• The easyScan SPM electronics is not connected to the power supply:

- check that the power LEDs on the electronics are on.

- check the connection.

• The easyScan SPM electronics is not connected to the computer:

 - check the connection.

• The wrong COM-port has been selected during software installation:

- Use , and select the correct COM-port in the dialog:

• The scan electronics is performing a task which lasts an unforeseen length
of time causing a time-out. Using Windows NT this can happen when
the system is occupied with itself and blocks the serial port:

- Use .

PROBLEMS AND SOLUTIONS
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• The electronics is damaged.

- Contact your dealer.

Sample holder moves too slowly / stops sometimes

If the fine approach using  and  is affected:

- Clean the sample holder, guide bars and the surfaces of the approach
motor following the procedure described in chapter Maintenance.

‘Approach’ is too slow / stops sometimes

- Clean the sample holder guide bars and the surfaces following the proce-
dure  described in chapter Maintenance. Let the parts dry sufficiently.

- If cleaning was no improvement open the ‘Approach Panel’s extended
configuration using .

- Increase the value of ‘Stepsize’ and click .

Now the motor moves the sample holder with larger steps during automatic
approach.

- Save the new value for ‘Stepsize’ using menu ‘File->Parameters->Save’

Tip often crashes into sample during ‘Approach’

In this case the motor moves the sample holder with too bigger steps to-
wards the tip:

- Open the ‘Approach Panel’s extended configuration using .

- Decrease the value ‘Stepsize’ in ‘Automatic Move Configuration’ by about
10% and click .

- Repeat the approach with a new tip. If the approach fails again, reduce
‘Stepsize’ further.

- Save the best ‘Stepsize’ value using menu ‘File->Parameters->Save’

PROBLEMS AND SOLUTIONS
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Image quality suddenly deteriorates

• When a scan line suddenly starts reproducing badly, the tip may have
picked up some particles, or it is scanning close to a deformity in the
sample's surface.

- Continue measuring for a while (4-5 images) eventually the tip loses
the picked up material again.

- Increase the scan range, and zoom into a new flat area.

- You can try to induce changes at the tip’s end: While measuring in-
crease the gap voltage in the ‘Feedback Panel’ to 2V then reduce it to
the old value again.

- You can also induce changes of the tip’s end by increasing the tunnel-
ing current to 20nA for a short time then reducing it to its old value
again.

- Retract the sample using  then perform a new approach.

If no improvement can be seen after going through these procedures, you
have to prepare a new tip.

• Did the scan line in the ‘LineView’ suddenly disappear and the LED on
the scanner turns orange the tip has lost contact:

- Use  in the ‘Approach Panel’ then repeat the steps in chap-
ter ‘Start measurement’.

• If the LED flashes green-orange while measuring then the tip is losing
contact from time to time and the tunneling contact is very unstable.

- Click  in the ‘Approach Panel’, then  and repeat
the steps in chapter ‘Start measurement’.

Cutting a new tip

After a crash (the tip with the sample) or when scan lines start reproducing
badly and consequently the image deteriorates you should proceed as fol-
lows:

- Remove the magnifying cover from the scan head.

PROBLEMS AND SOLUTIONS
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- Retract the sample holder first by using  then . Remove
the sample holder by hand.

- Pull the tip out from under the tip holders carefully, using a pair of sharp
tweezers.

- Carefully follow the instructions in chapter ‘Preparing and installing the
tip’.

- Repeat procedures in chapter ‘Measuring graphite’.

Z-Offset does not change automatically

In the default configuration of the easyScan E-Line software the item in
menu ‘Options->Auto. Adjust Z-Offset’ is activated. If the numeric value
of ‘Z-Offset’ in the ‘Scan Panel’ does not alter slightly during scan:

- Check that the option is activated.

- The scan line is at one of the limits of the z-range. Increase the value of
‘Z-Range’.

- Possibly the tip is at one of the limit positions of the z-piezo. Use
 then .

PROBLEMS AND SOLUTIONS
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Technical Data

The specifications given here are typical values of the Nanosurf products.
The exact specifications vary somewhat from instrument to instrument,
and are stored on the installation CD, and can be found in the Calibration
dialog (see Software Reference).

Scan ranges and resolution

Maximum XY-Scan range typ. 0.5 µm (1 µm optional)

Maximum Z-range 200 nm

Drive resolution Z 0.003 nm

Drive resolution XY 0.015 nm

gap voltage ±10V in 5mV steps

Set point current ±100nA in 25pA steps

sample size max. 10mm diameter

The exact values are dependent on the calibration of the piezo elements.
Drive resolution is calculated by dividing the scan range over 16 bits.

easyScan electronics

Max. scan speed: 1800 data points per second

feedback loop bandwidth: 3 kHz

Additional User ADC Input: Option available

TECHNICAL DATA
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